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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the 

products supplied by Meggitt SA (Meggitt Sensing Systems) are based on information believed to be 

reliable, but unless otherwise expressly agreed in writing with Meggitt SA the accuracy or 

completeness of such data is not guaranteed. Before using this product, you must evaluate it and 

determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, 

user manuals, service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability 

associated with use of the product. Meggitt SA takes no responsibility for any statements related to the 

product which are not contained in a current English language Meggitt SA (Meggitt Sensing Systems) 

publication, nor for any statements contained in extracts, summaries, translations or any other 

documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for 

new products purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 

 

About these release notes 

This document provides important information about the VibroSight
®
 software from Meggitt Sensing 

Systems. It is applicable to all VibroSight-based condition monitoring systems using the versions of 

software described by this document, namely: 

 VibroSight software version 3.5.0 (CD part number 609-004-000-042). 

This document contains information about changes to the software since the previously released 

version (VibroSight 3.4.0), such as new features and improvements, solved problems and bug fixes, 

and hardware and software compatibility. 

For more general information on the actual software, or the entire condition monitoring system (CMS), 

refer to the following Meggitt Sensing Systems (MSS) documentation: 

 VibroSight software data sheet 

        (MSS document ref. 660-020-005-218A) 

 Getting started with VibroSight installation guide 

        (MSS document ref. 660-010-006-221A) 

 VibroSight help 

 VM600 XMV16 / XIO16T extended vibration monitoring card pair data sheet 

        (MSS document ref. 660-020-010-208A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in 

earlier versions of the software: 

 VibroSight 2.9.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.1 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.2 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.4 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.5 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.6 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.9.7 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.0 (MSS document ref. VIBROSIGHT-RN/E) 

 VibroSight 2.10.1 (MSS document ref. 660-010-013-201A) 

 VibroSight 2.11.0 (MSS document ref. 660-010-013-203A) 

 VibroSight 2.11.1 (MSS document ref. 660-010-013-204A) 

 VibroSight 2.11.2 (MSS document ref. 660-010-013-205A) 
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 VibroSight 2.11.3 (MSS document ref. 660-010-013-206A) 

 VibroSight 2.11.4 (MSS document ref. 660-010-013-207A) 

 VibroSight 2.11.5 (MSS document ref. 660-010-013-208A) 

 VibroSight 2.11.6 (MSS document ref. 660-010-013-209A) 

 VibroSight 2.12.0 (MSS document ref. 660-010-013-210A) 

 VibroSight 2.12.1 (MSS document ref. 660-010-013-211A) 

 VibroSight 2.12.2 (MSS document ref. 660-010-013-212A) 

 VibroSight 2.12.3 (MSS document ref. 660-010-013-213A) 

 VibroSight 2.12.4 (MSS document ref. 660-010-013-214A) 

 VibroSight 2.12.5 (MSS document ref. 660-010-013-215A) 

 VibroSight 2.12.6 (MSS document ref. 660-010-013-216A) 

 VibroSight 2.12.7 (MSS document ref. 660-010-013-217A) 

 VibroSight 3.0.0 (MSS document ref. 660-010-013-218A) 

 VibroSight 3.1.0 (MSS document ref. 660-010-013-219A) 

 VibroSight 3.2.0 (MSS document ref. 660-010-013-220A) 

 VibroSight 3.3.0 (MSS document ref. 660-010-013-221A). 

 VibroSight 3.4.0 (MSS document ref. 660-010-013-222A). 

 

Structure of the release notes 

This document presents information in the following order: general items first, then in terms of the 

software modules that constitute VibroSight, such as  Configurator,  Event Viewer,  Mimic, 

 Scope,  Server,  System Manager and  Vision. 

You should read those sections that are most relevant to you and then keep the document for future 

reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following 

information: 

 Major release identifier: x.x.x.x 

 Minor release identifier: x.x.x.x 

 Update release identifier: x.x.x.x 

 Maintenance (build) release identifier: x.x.x.x 
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For each scheduled release of VibroSight, at least one of the first three digits changes (x.x.x.x). 

For unscheduled releases, that are occasionally required to solve urgent problems, only the fourth 

digit changes (x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using 

Help > About … in any VibroSight software module). 

 

Terminology 

To distinguish between the different Meggitt Sensing System products that can be used with the 

VibroSight
®
 software, the following terminology is used in this document: 

 VM600 card – to refer to the VibroSight-software compatible cards that are installed in a VM600 

rack. The currently available VM600 cards that are designed for operation with the VibroSight 

software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T) and the new CPUR/IOCR card pair. 

Where CPUx card is used in this document, it refers to CPUM and CPUR cards, and where 

IOCx card is used in this document, it refers to IOCN and IOCR cards, unless otherwise stated. 

Where XMx16 card is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and 

XMVS16 / XIO16T cards, unless otherwise stated. 

 VibroSmart
®
 module or VibroSmart

®
 device – to refer to VibroSight-software compatible 

modules or devices that are used in a distributed monitoring system. The currently available 

VibroSmart modules and devices that are designed for operation with the VibroSight software 

are the VSI010, VSN010 and VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x 

modules, unless otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to 

the VSI010 and VSV30x modules and the VSN010 device, unless otherwise stated. 
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1 Licensing 

In general, the licence required to enable purchased product options remains unchanged between 

update and/or maintenance level releases, for example, from version 3.4.0 to version 3.5.0. 

However, a new licence is always required for upgrades between major level releases, for example, 

from version 2.x.x to version 3.x.x. 

NOTE: VibroSight 3.5.0 is a minor level release and a new licence key file is not required 

for upgrades from VibroSight 3.4.0. 

However, a new licence key file is required for upgrades from VibroSight 2.x.x. 

 

To obtain a new VibroSight licence key file or for further information on licence keys, contact Meggitt 

Sensing Systems customer support. See 7 Customer support. 

 

2 Features 

General 

2.1 Improved support for remote monitoring and diagnostics 

The VibroSight software now includes improved support for remote monitoring and diagnostics – by 

supporting secure data replication via a data diode in order to create a near real-time replica/mirror of 

a remote data repository in a central diagnostics centre. 

NOTE: A data diode, also known as a unidirectional security gateway or unidirectional 

network, is a network device that allows data to travel in one direction only, in order 

to help ensure data/information/network security. 

Data diodes are typically used to create a physically secure one-way 

communication channel from one side of a network to another. 

 

In the world of machinery monitoring and protection, remote monitoring and diagnostics is being used 

more and more in order to monitor multiple sites. This approach requires a central office acting as a 

centre of excellence/expertise, staffed by machinery monitoring and diagnostics experts who support 

machinery installed throughout the world. Using a central diagnostics centre has numerous 

advantages that can help improve operational efficiency, for example, improved response times and 

reduced costs due to the reduction or even elimination of the requirement to travel. 

However, we live in a time when cyber attacks against industrial control systems and critical 

infrastructure such as power plants are increasing. Correspondingly, cyber security is becoming a 

priority for owners and operators of power plants, who must now consider cyber security and have an 

appropriate security plan or strategy in place. 

NOTE: Cyber security must be considered at a system level and various factors such as 

risks and awareness, human factors, training, physical security, remote access and 

the sharing of information must all be considered in order to ensure a robust and 

reliable plan/strategy. 
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As part of a cyber security strategy, one of the ways to provide secure access to data for a central 

diagnostics centre is through the use of data diodes, as shown in Figure 1. 

 

Figure 1: VibroSight support for remote monitoring and diagnostics 
using data diodes for increased security 

In a remote site (left of Figure 1), which is a high security environment, a VibroSight Server runs as 

part of the locally installed condition monitoring system. From the local data repository (VibroSight 

historical data folder (*.vshdf) file) used by the VibroSight Server, VibroSight historical data archive 

(*.vshda) files can be generated in order to share data with a central diagnostics centre. 

NOTE: A remote VibroSight Server must be configured to generate VibroSight historical 

data archive (*.vshda) files at a data rate that is suitable for the application. 

The data update rate required for the remote monitoring and diagnostics of live 

data is usually of the order of minutes. 

 

A third-party tool is used to copy the VibroSight historical data archive (*.vshda) files from a remote 

site (higher-security level) – via a secure data diode – to a central diagnostics centre (lower-security 

level). 

NOTE: Since data diodes are unidirectional, it is not possible to use them to gain access to 

and interfere in the operation of the machinery being monitored. 
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In the central diagnostics centre (right of Figure 1), a central VibroSight Server acts as replica/mirror 

data repository for a remote site. (What’s the ratio/limit? For example: 1:1, 1:10 or 10:1.) That is, the 

central VibroSight Server automatically accesses and collates the data from the VibroSight historical 

data archive (*.vshda) files copied from a remote site. In this way, a local data repository (VibroSight 

historical data folder (*.vshdf) file) is created that is suitable for remote monitoring and diagnostics. 

NOTE: A central VibroSight Server must be configured to import VibroSight historical data 

archive (*.vshda) files from the designated local directory/folder used as the 

destination by the third-party file copying tool. 

The local data repository (VibroSight historical data folder (*.vshdf) file) created 

by a central VibroSight Server is a near real-time replica/mirror of the data from a 

remote data repositories. 

 

 

To configure and use a remote VibroSight Server for remote monitoring and diagnostics: 

 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration (File > New > VibroSight Server configuration) or 

open and modify an existing VibroSight Server configuration (File > Open > …). 

2. In the Hardware view, select the VibroSight Server configuration node (the root node in the 

hierarchical tree structure), then in the parameters window (centre), change the Name from the 

default (VibroSight Server configuration) to something more useful such as VibroSight_site1. 

NOTE: A remote VibroSight Server sharing data with a central VibroSight Server is identified by a 

unique ‘configuration identifier (GUID)’ which is automatically generated when a configuration is 

saved as a server / database and subsequently included in any associated VibroSight historical 

data archive (*.vshda) files. 

3. In the Hardware view, configure the hardware (VM600 racks, VibroSmart measurement blocks, 

external interfaces) and post-processing of the VibroSight Server in the usual way. 

4. In the Data storage view, configure the data logging and event logging (Data logging) of the 

remote VibroSight Server in the usual way. 

5. In the Data storage view, configure the integrated data management (Data Management) of the 

remote VibroSight Server in the usual way. 

6. In the Data storage view, at the Data Management node level, configure one or more Offline Data 

Storage operations to generate the VibroSight historical data archive (*.vshda) files that will be 

used to share data between this remote VibroSight Server and a central VibroSight Server, as 

follows: 

Right-click on the Data Management node, then click New Offline data storage. The parameters 

window (centre) updates to display the parameters for the Offline data storage operation. 
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In the parameters window (centre), configure the Offline data storage parameters in the usual 

way, paying special attention to the Data file time span and Total data span, and Storage folder 

and Filename parameters on the General tab, as follows: 

NOTE: For a central VibroSight Server, the data update rate depends on the frequency of 

availability of the VibroSight historical data archive (*.vshda) files. 

 

Data file time span: Defines the maximum size of each individual VibroSight historical data 

archive (*.vshda) file in terms of time range. For example, 1 minutes worth of data (1 min(s)). 

Total data span: Defines the maximum combined size for all of the individual VibroSight historical 

data archive (*.vshda) files. For example, 24 hours worth of data (24 hours(s)). 

NOTE: If both the Data file time span and Total data span controls are configured in terms of 

time, VibroSight uses these values to calculate the number of individual data archive (*.vshda) 

files that are required and updates the data file numbering (“Data file n”) in the user interface 

accordingly. 

Together, the individual individual data archive files act as a “rolling buffer” that is continually being 

rewritten in order to always have the most recent data available. That is, once the number “n” of 

individual data archive files required to cover the Total data span is reached, each time a new 

individual data archive file with the latest data becomes available, the oldest individual data 

archive file with the oldest data is automatically deleted. 

Using a “rolling buffer” to limit the number of individual data archive files in this way ensures that 

the latest data covering the Total data span is always available, while avoiding potential issues 

such as a disk-full situation. 

For applications such as remote monitoring and diagnostics, this “rolling buffer” is effectively a 

data buffer that can be used to help compensate for potential problems with the copying of 

VibroSight historical data archive (*.vshda) files from a remote site to a central diagnostics 

centre, for example, due to the temporary loss of a network connection. 

Storage folder and Filename: Defines the directory/folder and file names used by the VibroSight 

historical data archive (*.vshda) files. This information is required by the third-party tool that is 

used to copy the historical data archive files from the remote site to a central diagnostics centre. 

7. Create and activate the remote VibroSight Server in the usual way (File > Save as > Server / 

database, then File > Apply changes to running configuration). 

 

 

In the remote VibroSight Server user interface: 

1. On the Status tab, under Device drivers, ensure that any required device drivers are enabled, 

such as VM600 and/or VibroSmart. 

2. On the Status tab, under Server features, ensure that Data logging manager is enabled. 
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To configure and use a central VibroSight Server for remote monitoring and diagnostics: 

 

In VibroSight Configurator: 

1. Create a new VibroSight Server configuration (File > New > VibroSight Server configuration). 

2. In the Hardware view, select the VibroSight Server configuration node (the root node in the 

hierarchical tree structure), then in the parameters window (centre), change the Name from the 

default (VibroSight Server configuration) to something more useful such as VibroSight_centre. 

3. In the Hardware view, right-click on the External data sources node, then click New VSHDA 

data source. The parameters window (centre) updates to display the parameters for the external 

VSHDA data source. 

4. In the parameters window (centre), configure the external VSHDA data source parameters, as 

follows: 

Name: Use the default name for the external VSHDA data source or change it, as required. 

State: An external VSHDA data source is Enabled by default but can be Disabled, as required. 

Input directory: The location of the folder containing the VibroSight historical data archive 

(*.vshda) files from a remote site, that is, the external VSHDA data files. 

NOTE: This can be a folder on the computer running the central VibroSight Server or a network 

directory/folder. 

Remove VSHDA files after processing: When this check box is selected, the central VibroSight 

Server will automatically delete a VibroSight historical data archive (*.vshda) file from the input 

folder after it has finished with it. 

NOTE: It can be useful to see the VibroSight historical data archive (*.vshda) files in the input 

folder when initially configuring and working with a central VibroSight Server. But once the system 

is working as expected, it is recommended to select this check box to automatically delete them in 

order to reduce storage requirements (avoiding potential issues such as a disk-full situation). 

Remove invalid VSHDA files: When this check box is selected, the central VibroSight Server will 

automatically delete from the input folder any VibroSight historical data archive (*.vshda) files 

that do not match the remote VibroSight Server’s unique ‘configuration identifier (GUID)’ or any 

data archive files that are corrupted. 

NOTE: A central VibroSight Server automatically extracts and uses the remote VibroSight Server’s 

‘configuration identifier (GUID)’ from the first VibroSight historical data archive (*.vshda) file 

copied to its Input directory folder. 

5. In the Data storage view, configure the integrated data management (Data Management) of the 

central VibroSight Server in the usual way. 

6. Create and activate the central VibroSight Server in the usual way (File > Save as > Server / 

database, then File > Apply changes to running configuration). 
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In the central VibroSight Server user interface: 

1. On the Status tab, under Server features, ensure that VSHDA import is enabled. 

2. On the Status tab, under Server features, ensure that Data logging manager is enabled if the 

central VibroSight Server is required to log data to its data repository. 

NOTE: If the central VibroSight Server is to be used for the display of live data only, then data 

logging is not required. 

 

Once a configuration is activated (applied) to a central VibroSight Server and VSHDA import and 

Data logging manager are enabled, the central VibroSight Server is ready to start the import and 

collation of data from a remote site. 

NOTE: For a central VibroSight Server, the data update rate depends on the availability of 

the VibroSight historical data archive (*.vshda) files in the input folder monitored 

by the central VibroSight Server. 

 

In practice, a central VibroSight Server continuously monitors the designated directory/folder (Input 

directory) for VibroSight historical data archive (*.vshda) files. As the historical data archive files 

appear in the designated directory/folder, the VibroSight Server uses the unique ‘configuration 

identifier (GUID)’ and timestamps of the files to help organise and sort them before parsing the files 

and adding the data to its own local data repository (VibroSight historical data folder (*.vshdf) file). 

 

 

In VibroSight Vision: 

1. Create a new project (File > New project) using VibroSight Server as the data source, then 

select and connect to the central VibroSight Server (for example, VibroSight_centre). 

2. Use the Time range window to work with live (Live data) or historical (Machine states, Alarms or 

Custom historical) data, as required. 

 When working with live data, the update rate for the data displayed in a plot depends primarily 

on the availability of the VibroSight historical data archive (*.vshda) files in the input folder 

monitored by the central VibroSight Server. For example, for *.vshda files with a time span 

of 1 minute, a live data plot is updated approximately every 1 minute. 

 When working with historical data, the data displayed in a plot depends primarily on the 

availability of the data in the VibroSight historical data folder (*.vshdf) file used as the data 

repository by the central VibroSight Server (which in turn depends on the availability of the 

VibroSight historical data archive (*.vshda) in the input folder monitored by the central 

VibroSight Server). For example, for *.vshda files with a time span of 10 minutes, a historical 

data plot displays the most recent data in 10 minutes ‘chunks’. 
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2.2 Hydro air-gap monitoring for measurement chains providing 
current signals 

For the VibroSight software’s ‘Hydro air-gap monitoring’ application specific package, the Air-gap 

processing block previously compensated for input channels of VM600 XMx16 cards and VibroSmart 

VSV30x modules that were configured to use current signals (4 to 20 mA) by automatically removing a 

hard-coded offset of 4 mA. 

This automatic compensation for current inputs has now been removed from the Air-gap processing 

block as the waveforms provided by the VM600 XMx16 cards and VibroSmart VSV30x modules are 

already compensated (that is, the VM600 XMx16 cards and VibroSmart VSV30x modules themselves 

implement any required offset compensation for input signals, depending on the configuration). 

 

 VibroSight Vision 

2.3 Improved cursor and zooming in Polar plots 

The Polar plot has been updated to use the same cursor style and behavior as the other VibroSight 

plots, as follows: 

 The cursor now consists of a dashed radial line with a small square marker to indicate where the 

cursor intersects the measurement data. 

NOTE: The small square marker where the cursor intersects the measurement data makes 

it easier to visually locate and track the cursor and the measurement data. 

 

The Polar plot has also been updated to use the same zoom behavior as the other VibroSight plots. 

That is, it now supports zooming using the mouse wheel, as follows: 

 In the Polar plot or the associated trends, rotating the mouse wheel forwards will zoom in, 

centered around the position of the pointer. This is the mouse wheel equivalent of Frame zoom 

using the pointer. 

Similarly, in the associated trends, CTRL + rotating the mouse wheel forwards will zoom in 

vertically (that is, the X-axis remains as it was and the Y-axis zooms). This is the mouse wheel 

equivalent of Vertical zoom using the pointer. 

Similarly, in the associated trends, SHIFT + rotating the mouse wheel forwards will zoom in 

horizontally (that is, the X-axis zooms and the Y-axis remains as it was). This is the mouse wheel 

equivalent of Horizontal zoom using the pointer. 

 In the Polar plot or the associated trends, rotating the mouse wheel backwards will zoom out, 

centered around the position of the pointer. 

Similarly, in the associated trends, CTRL + rotating the mouse wheel backwards will zoom out 

vertically (that is, the X-axis remains as it was and the Y-axis zooms). 

Similarly, in the associated trends, SHIFT + rotating the mouse wheel backwards will zoom out 

horizontally (that is, the X-axis zooms and the Y-axis remains as it was). 

 

As before, using the ESC key or the Zoom reset button on the toolbar resets the plot to how it was 

initially displayed, that is, with no zoom. 
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2.4 Display of phase data in Trend, Bode and Polar plots 

The Trend, Bode and Polar plots have been updated to display data in the phase chart in accordance 

with the selected (Phase) Qualifier, as follows: 

 Qualifier: Lag 0 to 360° or Lag −180 to 180° – Phase increases looking from top to bottom of 

the phase chart. That is, phase lag values increase going downwards. 

(Previously, phase lag values increased going upwards.) 

 Qualifier: Lead 0 to 360° or Lead −180 to 180° – Phase increases looking from bottom to top of 

the phase chart. That is, phase lead values increase going upwards. 

 

2.5 Display of amplitude, phase and frequency charts in Trend, Bode and 
Polar plots 

The Trend, Bode and Polar plots have been updated to support the display of the amplitude, phase 

and frequency ps in different orders of display. 

When a Trend, Bode or Polar plot is displayed, the order of display of the amplitude (physical 

quantity), phase and frequency charts depends on the plot layout convention, as follows: 

 Plot layout convention: European (EU) – Order of display is amplitude, phase and then 

frequency (looking from top to bottom). This is the default plot layout convention. 

 Plot layout convention: American (US) – Order of display is phase, amplitude and then 

frequency (looking from top to bottom). 

(Previously, for Trend, Bode and Polar plots, the order of display was fixed as amplitude, phase and 

frequency (looking from top to bottom), equivalent to the new European (EU) plot layout convention. 

NOTE: For Trend, Bode and Polar plots, only amplitude and phase (or phase and 

amplitude) charts are displayed, when no frequency data is available. 

 

By default, the plot layout convention is European (EU). 

 

However, the plot layout convention can easily be changed using the Unit preferences and 

conventions (previously known as Unit preferences). For example: 

1. In VibroSight Vision, click Tools > Unit preferences and conventions. 

The Unit preferences and conventions window is displayed. 

2. In the Unit preferences and conventions window, ensure that an editable Unit set is selected, that 

is, not Metric and not Imperial. 

The standard Metric and Imperial unit sets included with VibroSight are read-only and cannot be 

edited. 

However, customisable unit sets can be created by the user, for example, by copying a standard 

unit set or importing a unit set from another VibroSight installation. These non-standard unit sets 

can be customised as required by a user. 

3. In the Unit preferences and conventions window, use the Plot layout convention control (bottom) 

to select European (EU) or American (US), as required. 
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4. Click OK to save any changes, then Exit (close) VibroSight Vision. 

When unit references are changes, the VibroSight software must be restarted in order for the 

changes to take effect. 

5. Start VibroSight Vision and create a Trend, Bode and/or Polar plot as usual. 

The order of display of the amplitude, phase and frequency charts is as per the configured plot 

layout convention. 

 

2.6 Displaying data against speed in Polar plots 

The Polar plot and the optimised data handling implemented by the VibroSight software have been 

updated to support the improved plotting of measurement data against speed. 

More specifically, when a Polar plot is configured as Speed (as opposed to Time) so that the 

measurement data (Radial-axis and Angular-axis) is displayed against speed, VibroSight’s optimised 

data handling algorithm now reduces (decimates) and optimises the data selected for display more 

intelligently in order to increase the number of points displayed in the plot at any one time in order to 

provide an improved ‘picture’ of measurement data against speed. 

(Previously, VibroSight’s optimised data handling algorithm (decimation) was supported by the Polar 

plot for measurement data against time only.) 

 

2.7 Improved Spectrogram plots 

The Spectrogram plot has been updated to support the improved plotting and analysis of 

measurement data in the following ways. 

 The Spectrogram plot now includes more spectra. 

A hard-coded maximum of 250 spectra can now be included in a Spectrogram plot in order to 

generate a more precise plot – a compromise between plotting and system performance. 

(Previously, a soft-coded maximum of typically 42 spectra was included in a Spectrogram plot, 

that is, display resolution width (in pixels) / 45. For example, 1920 pixels / 45 ≈ 42.) 

 The Spectrogram plot now uses an improved colour scale to display the physical quantity in order 

generate a more precise plot and allow more detailed analyses. 

A different palette (colour scheme) is now used with darker colours indicating lower values 

(black = min.), brighter colours indicating higher values (grey = max.) and white indicating no 

value. 

A different gradient (colour change) is now used with more colours and a more gradual change in 

colours that provides more information. 
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2.8 Improved Waterfall/Cascade plots 

The Waterfall/Cascade plot has been updated to support the improved plotting and analysis of 

measurement data in the following way. 

 The Waterfall/Cascade plot now includes more spectra. 

A hard-coded maximum of 250 spectra can now be included in a Waterfall/Cascade plot in order 

to generate a more precise plot – a compromise between plotting and system performance. 

(Previously, a soft-coded maximum of typically 42 spectra was included in a Waterfall/Cascade 

plot, that is, display resolution width (in pixels) / 45. For example, 1920 pixels / 45 ≈ 42.) 

 

2.9 Improved data export 

Data export from VibroSight Vision has been improved to now use the default unit or units specified for 

the physical quantity or quantities displayed in a plot. 

 

NOTE: The units and qualifiers required to be displayed in a plot can be changed as 

follows: 

 Globally for all plots – using the Unit preferences and conventions (previously 

known as Unit preferences), accessed by clicking Tools > Unit preferences 

and conventions. 

 Locally to individual plots – using the Plot properties, accessed by right-clicking 

a plot and clicking Plot properties, and then changing the Unit and/or Qualifier 

for the appropriate axis or axes. 

 

NOTE: The standard Metric and Imperial unit sets included with VibroSight are read-only 

and cannot be edited. 

However, customisable unit sets can be created by the user, for example, by 

copying a standard unit set or importing a unit set from another VibroSight 

installation. These non-standard unit sets can be customised as required by a user. 

 

(Previously, data export from VibroSight Vision used the ‘reference’ units specified for the physical 

quantities displayed in a plot. ‘Reference’ units are the units used internally by VibroSight for working 

with data.) 

 

 

 

  



     

 
 

   

     

 

     
 Release Notes VIBROSIGHT-RN/E (660-010-013-223A) 

Release 3.5.0 – April 2018 19 / 50  

     
 

3 Solved problems and bug fixes 

General 

3.1 Improvements and bug fixes 

General stability improvements across the VibroSight 3.5.0 software. 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time 

or Local computer time and the site time or local computer time is subsequently changed on the 

relevant computer (for example, using Windows > Control Panel > Date and Time), this change is not 

reflected in the VibroSight Vision user interface until the user clicks on the Timestamp displayed in 

the VibroSight Vision status bar. 

 

4.2 VibroSight Server and Host Service restart required after changes to 
network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or 

disconnected) on a computer running VibroSight, then the VibroSight Servers and Host Services 

running on the computer must be restarted in order for the network adapter to be recognized by the 

VibroSight discovery mechanism. 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 

27 characters were allowed in previous versions. This constraint is enforced during the creation of new 

server instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 

hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 

VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an 

upgrade of the VibroSight software. In such cases, the file names used for a VibroSight Server 

database file (*.vssrvdb or *.db) and a VibroSight Server configuration file (*.vssrvcfg or 

*.config) should be updated (and manually edited in the VibroSight configuration file) to be 

18 characters or less. Changes may also be required in any VibroSight software that references the 

server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 

(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that 

remain available for VibroSight Server instance names to three. Alternatively, the server instance 

name can be shorted after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any 

truncation performed by VibroSight, it is possible that servers are created with names that contain 

non-allowed characters (such as spaces), with the result that these servers will not be accessible by 

VibroSight software clients. Similarly, duplicate VibroSight Server names are also possible. 
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NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 

arising due to truncation and/or additional data repositories being created during 

automatic data management. 

This is particularly important for systems with automated data management and 

system backup procedures that can generate VibroSight Server data repositories 

with different file names. 

 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, 

UTC time or Local computer time, all other VibroSight client software modules continue to display 

timestamps in local computer time only (that is, the date and time according to the local clock of the 

computer running the VibroSight software module). 

 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always 

update correctly to show all of the devices (VM600 cards and VibroSmart devices) available on the 

network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a 

refresh (using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

 Wait a few minutes and refresh again. 

 Restart VibroSight System Manager. 

 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight 

Mimic client software module for mimics (that were previously available in VibroSight Vision). As a 

result, VibroSight Vision mimics created with VibroSight 2.9.7 or earlier are not compatible with 

VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client 

software module. As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are 

not compatible with VibroSight 2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to 

include version information, in order to improve the compatibility between projects created with 

different versions of VibroSight Mimic and eliminate the requirement for the recreation of Mimics. 

Starting with VibroSight 2.11.5, Mimic projects automatically detect any changes in the VibroSight 

Mimic software that affect project compatibility, inform the user and update the project as required. 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 

VibroSight 2.11.0 or later, if the corresponding database had been updated as 

required. 
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NOTE: When updating existing machinery monitoring projects created with 

VibroSight 2.12.x to VibroSight 3.x.x, a new data repository created by copying a 

VibroSight database (*.vssrvdb) to a VibroSight historical data folder (*.vshdf) 

must use the same server file name as the existing server in order for existing 

VibroSight Mimics to maintain links with the data repository and continue to work 

(without manual corrections). 

In addition, the VibroSight Server using the new data repository must be running 

before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a 

VibroSight system and the external OPC server becomes unavailable, the VibroSight OPC Client may 

not always recover automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error 

messages even when OPC server is available and can result in permanent loss of the imported data if 

not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 

as expected. 

Any VibroSight system feature or configuration element relying on the imported 

OPC data will not behave as expected, for example, alarms, machinery operating 

conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

 Stop and restart the VibroSight OPC Client from either the VibroSight Server 

(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

 Stop and restart the VibroSight Server, if required. 

 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event 

information available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event 

information available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate 

events being listed in the Event Viewer, particularly for VibroSight systems being operated without an 

NTP server (where events are not recognised as duplicates due to time drift). 
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4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server 

are not correctly displayed and updated when an NVIDIA WMI driver is installed on the same 

computer as the VibroSight Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 

management and control technology that interfaces to Microsoft’s Windows 

Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 

processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required 

counter values from the underlying operating system / computer. 

 

4.10 XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing 

Block that is used as an input to a Dual Shaft Relative Processing Block which is configured to provide 

an Orbit and/or Full Spectrum output, then any pre-logging configured for the principal mode 

Waveform and/or Spectrum of Dynamic Input Channel 16 will not actually log any of the data from the 

same pre-logging scope. 

 

4.11 Problems creating new VibroSight OPC Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 

VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight 

OPC Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System 

Manager displaying an error message such as 

“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ 

threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight 

OPC Servers is being used by the later installation of VibroSight, which can happen in one of two 

ways: 

 When a later version of VibroSight 3.x.x is installed on a computer that was running an earlier 

version of VibroSight 2.x.x, the VibroSight installer automatically checks existing VibroSight folders 

(such as C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user 

preference files across to the new VibroSight folders (such as 

C:\ProgramData\Meggitt\VibroSight), including an earlier OpcServer.config file. 

 When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of 

a VibroSight OPC installer using VibroSight 3.0.0 automatically created an earlier 

OpcServer.config file. 
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As shown below, the first few lines of a typical OpcServer.config file contains version specific 

information that is incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems 

are experienced when creating new VibroSight OPC Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the 

version specific information. That is, change the line containing the section name 

from: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" 

type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 

XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 

    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 

    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Servers to VibroSight 3.x.x is 

described in detail in the “VibroSight OPC Server migration” section of the latest 

 Getting started with VibroSight installation guide. 
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4.12 Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with 

the VibroSight software. So if the computer running the VibroSight software is running other software 

which also requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight 

(or the other software) from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically 

detect other software on the computer that is using TCP port 50000 and report this. For example: “The 

port 50000 cannot be used. Please close all application using this port before manually starting the 

host service.” 

Accordingly, any potential TCP port 5000 conflict should be resolved before the VibroSight software 

can be successfully installed and run. 
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check 

to see if the required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package and 

OPC Core Components Redistributable software are pre-installed on the computer: 

 The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually 

installed before VibroSight can be installed. If it is not detected, then the VibroSight installer will 

exit the installation and VibroSight is not installed. 

 The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the 

VibroSight installer if it is not detected. 

 The required OPC Core Components Redistributable (see section 5.1.4) software is automatically 

installed on the computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 

VibroSight’s prerequisites and compatibility. 

 

5.1 VibroSight software 

VibroSight 3.5.0 is a minor level release and replaces VibroSight 3.4.0. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data 

migration process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data 

repositories based on the VibroSight historical data repositories (VibroSight historical data folder 

(*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data archive 

(*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers 

that were created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC 

Server migration process for these VibroSight OPC Servers. 

Therefore, it is important to note that: 

 New machinery monitoring projects created with VibroSight 3.x.x will automatically use VibroSight 

historical data repositories. 

 Existing machinery monitoring projects created with versions of VibroSight earlier than 

VibroSight 3.0.0 must be manually migrated from Sybase SQL Anywhere databases to VibroSight 

historical data repositories before they can be used with VibroSight 3.x.x. 

 Existing machinery monitoring projects using VibroSight OPC Servers that were created with 

versions of VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC 

Servers before they can be used with VibroSight 3.x.x. 

It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or 

earlier to VibroSight 3.x.x requires that certain steps must be performed using the existing version 

of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 
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NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” and “VibroSight OPC 

Server migration” sections of the latest  Getting started with VibroSight 

installation guide. 

 

5.1.1 Microsoft Windows operating systems 

VibroSight 3.x.x is compatible with 32-bit versions and 64-bit versions of Microsoft 
®
 Windows 

®
 

operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 

software for 64-bit Windows and 32-bit software for 32-bit Windows. 

The 64-bit version of VibroSight can be installed on 64-bit Windows computers 

only. The 32-bit version of VibroSight can be installed on 32-bit Windows 

computers only. Only a single version of VibroSight can be installed and exist on a 

computer at any one time 

 

See the Appendix of these release notes for further information on VibroSight software and Windows 

operating system compatibility. 

 

5.1.2 Microsoft .NET Framework 

For most Windows operating systems, VibroSight 3.4.0 or later requires that the Microsoft .NET 

Framework 4.7.1 or later is installed. 

NOTE: VibroSight 3.4.0 or later requires Microsoft .NET Framework 4.7.1. 

 

If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect 

this and automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft 

.NET Framework requirements. 

 

5.1.3 Microsoft Visual C++ Redistributable Package 

VibroSight 3.x.x requires that the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 

is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 

Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 

computers. 

 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight 

installer will detect this and exit the installation. 
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5.1.4 OPC Core Components Redistributable 

VibroSight 3.x.x requires that the OPC Core Components Redistributable is installed, in order to 

configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable 

must be installed on OPC client computers in order to allow connections to remote OPC servers and it 

must be installed on OPC server computers in order to allow OPC clients to browse for running OPC 

servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 

computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 

Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 

computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer 

will detect this and automatically install it as part of the VibroSight software installation. 

 

5.1.5 Sybase SQL Anywhere 11 software 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data 

folder (*.vshdf) for operation with a VibroSight Server (live data) and VibroSight historical data 

archive (*.vshda) for operation with historical data) are exclusively used for the required data 

repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a 

data repository. Accordingly, the Sybase SQL Anywhere 11 database software is no longer included 

and distributed as part of the VibroSight software. 

NOTE: VibroSight 3.x.x exclusively uses data repositories based on the VibroSight 

historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 

databases and introduced initial support for working with data repositories based 

on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 

SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 

VibroSight 3.x.x is described in detail in the “Data migration” section of the latest 

 Getting started with VibroSight installation guide. 
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5.1.6 VM600 CMS software 

The VM600 CMS software from Meggitt Sensing Systems uses Sybase SQL Anywhere 8. Both 

Sybase SQL Anywhere 8 (VM600 CMS) and Sybase SQL Anywhere 11 (VibroSight) can be installed 

on the same computer. 

However, while SQL Anywhere 8 and SQL Anywhere 11 can be installed on the same computer and 

run at the same time for standard database operations, certain administrative tasks are mutually 

exclusive and may block one another. 

More specifically, all operations that refer to Sybase SQL (a command-line Interactive SQL utility) in 

the background could be directed to the wrong version of Sybase SQL Anywhere. For example, this 

impacts all user operations and system operations involving the creation, copying and updating of 

databases. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have VM600 CMS software installed. 

 

5.1.7 SIMATIC Step 7 software 

The SIMATIC Step 7 software from Siemens typically uses Sybase SQL Anywhere 9. Both Sybase 

SQL Anywhere 9 (SIMATIC Step 7) and Sybase SQL Anywhere 11 (VibroSight) can be installed on 

the same computer. 

However, while SQL Anywhere 9 and SQL Anywhere 11 can be installed on the same computer, they 

cannot run at the same time. 

More specifically, if SIMATIC Step 7 and VibroSight are both installed, certain administrative tasks, 

such as all user operations and system operations involving the creation, copying and updating of data 

repositories (databases), may not work correctly. If this behaviour is seen, the recommended 

workaround is to manually change or remove the SQLANY environmental variable in order to allow 

VibroSight to work correctly. 

Note: The SQLANY environment variable is used to contain the directory where Sybase SQL 

Anywhere is installed. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have SIMATIC Step 7 software installed. 

 

5.1.8 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience 

problems running the VibroSight software, characterised by the VibroSight software not running or 

running incorrectly. This is because the Dell Backup and Recovery software can use a version of 

SQLite and associated libraries (DLLs) that prevent the VibroSight Host Service from running 

correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect 

to data sources and/or VibroSight System manager may not display all of the commands expected to 

be available in the Actions window. 
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If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery 

software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 

does not have Dell Backup and Recovery software installed. 

 

5.1.9 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same 

computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in 

problems related to credentials (access rights). These problems are typically characterised by an 

unhandled exception in VibroSight Configurator when trying to configure an OPC device in the 

Hardware view or an unhandled exception in a VibroSight Server when trying to handle/process OPC 

data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the 

following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 

Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 

or later). Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x. 
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5.2 VM600 cards 

5.2.1 Firmware 

There are no firmware updates for VM600 cards corresponding to VibroSight 3.5.0. 

The latest firmware for the CPUR remains: 

 Base System: base-system-640-014-001-002.tgz 

 Applications:  applications-640-015-001-002.tgz. 

The latest firmware for the XMC16, XMV16 and XMVS16 remains: 

 Base System: base-system-640-003-001-016.tgz 

 Applications:  applications-640-010-001-016.tgz. 

Therefore, for current versions of VM600 cards, firmware upgrades are not required. 

 

5.3 VibroSmart devices 

5.3.1 Firmware 

There are no firmware updates for VibroSmart modules and devices corresponding to 

VibroSight 3.5.0. 

The latest firmware for the VSI010 module remains: 

 642-002-000-009.xmsifw. 

The latest firmware for the VSN010 device remains: 

 642-004-000-011.redboxfw. 

The latest firmware for the VSV30x module remains: 

 642-001-000-015.xtranfw. 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are not 

required. 

 

6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. 

Perform the steps in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 

hardware (XMx16 cards and VibroSmart modules and devices) before starting a 

VibroSight system upgrade, in order to establish if any firmware updates are also 

required. 

See 6.2.3 Updating the firmware using VibroSight System Manager. 
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NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. See 6.2.3 Updating the 

firmware using VibroSight System Manager. 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer 

running VibroSight to keep track of user-configurable settings, so that these settings are remembered 

and applied for the VibroSight installation. 

These settings files have an .xmssettings file name extension and on a computer running 

Windows 7, can be found here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows 

account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default 

settings for VibroSight Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 

• For a computer on which VibroSight was previously installed, an update, upgrade 

or a re-installation of VibroSight will continue to use the previous defaults recorded 

in the .xmssettings files. 

• For a computer on which VibroSight was not previously installed, the installation 

of VibroSight will generate and use new .xmssettings files, which use the latest 

VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 

settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600 cards (XMx16) and 

VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 

take advantage of improvements to the VibroSight software. 

Updating the firmware VM600 cards or VibroSmart devices is a special task that can, if used 

unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 

acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal 

machinery monitoring functions because its outputs (alarms and relays) can go to undetermined 

states, irrespective of how they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware 

update and the restart (reboot) that is triggered automatically after the firmware update (which can 

take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 

with the operating procedures for the machinery being monitored and that 

appropriate precautions are taken at the control system level (such as DCS 

or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 

order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600 card firmware 

The latest VM600 card firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600 cards is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600 card can be found in the appropriate subfolder and identified by their 

.tgz file name extension. For example, the XMV16 subfolder contains the applications and base 

system firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt 

Sensing Systems should also be stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that 

is, CPUR firmware). 

Table 2 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that 

is, XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 

firmware and VM600 XMx16 firmware that is compatible with the version of 

VibroSight software being used. 
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Table 1: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware. See note 1 

VibroSight software 

version 

CD part number 

Base-system (*.tgz) 

640-014-001-001 640-014-001-002 

Applications (*.tgz) 

640-015-001-001 640-015-001-002 

2.12.7 

609-004-000-036 
 

See note 2
  

See note 3
 

3.0.0 

609-004-000-037 
  

3.1.0 

609-004-000-038 
  

3.2.0 

609-004-000-039 
  

3.3.0 

609-004-000-040 
  

3.4.0 

609-004-000-041 
  

3.5.0 

609-004-000-042 
  

 

Notes for Table 1 

1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

014-001-xxx for the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-014-000-xxx for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This is the first official release of VM600 CPUR firmware and includes features such as the management of XMx16 card 

configurations for applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus 

interfaces. A firmware upgrade is required in order to run VibroSight 2.12.7 or later. 

 

3. This version of VM600 CPUR firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus 

server to 100 ms (was 200 ms) and fixing a known time counter wraparound (overflow) issue. A firmware upgrade is strongly 

recommended in order to run VibroSight 3.4.0 or later. 
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Table 2: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware. See note 1 

VibroSight 

software 

version 

CD part number 

Base-system (*.tgz) 

640-003- 

001-011 

640-003- 

001-012 

640-003- 

001-013 

640-003- 

001-014 

640-003- 

001-016 

Applications (*.tgz) 

640-010- 

001-011 

640-010- 

001-012 

640-010- 

001-013 

640-010- 

001-014 

640-010- 

001-016 

2.12.3 

609-004-000-030 
 

See note 2
 

    

2.12.4 

609-004-000-032 
 

    

2.12.5 

609-004-000-033 
  

See note 3
 

   

2.12.6 

609-004-000-034 
  

   

2.12.7 

609-004-000-036 
   

See note 4
  

 

3.0.0 

609-004-000-037 
    

See note 5
  

3.1.0 

609-004-000-038 
     

3.2.0 

609-004-000-039 
     

3.3.0 

609-004-000-040 
     

See note 6
 

3.4.0 

609-004-000-041 
     

3.5.0 

609-004-000-042 
     

 

Notes for Table 2 (see the next page)  
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Notes for Table 2 

1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-

003-001-xxx for the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx 

denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog 

box displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using 

PNRs such as 640-010-000-xxx for the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual 

unpacked firmware that is running on the card. 

 

2. This version of VM600 XMx16 firmware introduces support for 1 s time-boxed peak-hold processing (that is, spectral data 

aggregation). 

 

3. This version of VM600 XMx16 firmware implements improved multi-rate digital resamplers (sample rate converters). 

A firmware upgrade is recommended but not required in order to run VibroSight 2.12.5 or 2.12.6. 

 

4. This version of VM600 XMx16 firmware improves support for faster live data: 100 ms card update rate and up to 100 ms 

VibroSight Vision refresh rate. It also allows a VM600 XMx16 card to be managed by a VM600 CPUR card (“rack controller”), 

eliminating the XMx16 card’s requirement for a VibroSight Server. A firmware upgrade is required in order to run 

VibroSight 2.12.7. 

 

5. This version of VM600 XMx16 firmware adds support for customer-specific functionality that is enabled by a customer-specific 

VibroSight software licence. A firmware upgrade is required in order to run VibroSight 3.0.0 or later. 

 

6. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised 

memory to reduce the possibility of missing data in data intensive VibroSight applications running on less powerful computers. A 

firmware upgrade is required in order to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the 

VibroSight software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 

C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by 

their .*fw file name extension. For example, the VSV30x subfolder contains the firmware for use by 

VSV30x modules. Any additional firmware updates received from Meggitt Sensing Systems should 

also be stored in these directories. 

Table 3 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 4 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 5 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 

firmware that is compatible with the version of VibroSight software being used. 
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Table 3: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw). See note 1 

VibroSight 

software version 

CD part number 

642-002 

-000-006 

642-002- 

000-007 

642-002- 

000-008 

642-002- 

000-009 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

3.4.0 

609-004-000-041 
    

3.5.0 

609-004-000-042 
    

 

Notes for Table 3 (see the next page)  
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Notes for Table 3 

1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-

xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 4: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-004- 

000-008 

642-004- 

000-009 

642-004- 

000-010 

642-004- 

000-011 

2.12.0 

609-004-000-027 


 See note 2
 

   

2.12.1 

609-004-000-028 
 

 See note 2
 

  

2.12.2 

609-004-000-029 
  

  

2.12.3 

609-004-000-030 
  

 See note 2
 

 

2.12.4 

609-004-000-032 
   

 

2.12.5 

609-004-000-033 
   

 

2.12.6 

609-004-000-034 
   

 See note 2
 

2.12.7 

609-004-000-036 
    

3.0.0 

609-004-000-037 
    

3.1.0 

609-004-000-038 
    

3.2.0 

609-004-000-039 
    

3.3.0 

609-004-000-040 
    

3.4.0 

609-004-000-041 
    

3.5.0 

609-004-000-042 
    

 

Notes for Table 4 (see the next page)  
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Notes for Table 4 

1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 5: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw). See note 1 

VibroSight 

software 

version 

CD part number 

642-001-000-

010 

642-001-

000-011 

642-001-

000-012 

642-001-

000-013 

642-001-

000-014 

642-001-

000-015 

2.12.0 

609-004-000-027 


 See note 2
 

     

2.12.1 

609-004-000-028 
 

 See note 2
 

    

2.12.2 

609-004-000-029 
  

    

2.12.3 

609-004-000-030 
  

 See note 2
 

   

2.12.4 

609-004-000-032 
   

   

2.12.5 

609-004-000-033 
   

 See note 2
 

  

2.12.6 

609-004-000-034 
    

 See note 2
 

 

2.12.7 

609-004-000-036 
     

 

3.0.0 

609-004-000-037 
     

 

3.1.0 

609-004-000-038 
     

 

3.2.0 

609-004-000-039 
     

 

3.3.0 

609-004-000-040 
     

 

3.4.0 

609-004-000-041 
     


See notes 

2 and 3
 

3.5.0 

609-004-000-042 
      

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 

1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-

000-xxx. In these PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight 

System Manager always uses and displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-

xxx, which correspond to the actual firmware that is running on the device. 

 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-

time Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In 

addition, VibroSight System Manager should be exited (closed) and restarted after updating the firmware for each type of 

device, before continuing. And after updating the firmware, the configuration on the VibroSmart devices should be re-applied 

(re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, 

using the currently installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to 

updates to VibroSmart devices), VibroSight Configurator can be used to obtain a copy of the configuration as follows: 

• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the 

configuration from the VibroSight Server. 

• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can 

be used to read the configuration directly from the VibroSmart modules. 

Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x 

modules) and run the Change Firmware command. 

When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be 

used to select multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change 

Firmware command is run, all of devices that were selected will be updated at the same time. Otherwise, each device must be 

selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has 

been upgraded successfully …” message, click the Finish button to continue. 

If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the 

Cancel button to close the window and continue. 

Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was 

updated. (When a device is selected in the System Explorer window, this information is available in the main window (centre) 

under Module PNR. It is also available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and 

the Change Firmware command is run). 

If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 

Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the 

configuration. (If required, VibroSight Configurator will automatically update the configuration to the latest version and inform the 

user.) 

Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that 

the system operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be 

inconsistent and should be ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 

 

3. This version of VibroSmart VSV30x firmware introduces support for hydro air-gap monitoring. 

A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade 

the firmware of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600 card firmware update may lead to 

incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only 

in systems where the firmware running on the XMx16 cards and VibroSmart devices already 

corresponds to the latest available version that no firmware update is required. Therefore, it is strongly 

recommended to verify the version of firmware running on the hardware before starting a VibroSight 

system upgrade, in order to establish if a firmware update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 

that can – if performed unintentionally – affect the proper functioning of data 

acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 

hardware only when it is necessary. For example, when the devices must be 

updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. 

Alternatively, multiple modules of the same type (for example, VSV3x0) can be updated to the same 

version of firmware at the same time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 

VibroSmart is available before updating the firmware of any of the VibroSmart 

modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 

updates to the VibroSight software corresponding to updates to VibroSmart 

modules), VibroSight Configurator should be used to obtain a copy of the 

configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 

command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 

VibroSmart), the File > Open > Device command can be used to read the 

configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 

configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight 

System Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the 

hardware (XMx16 card or VibroSmart module or device) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System 

Explorer window. 
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The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the 

network. If there are no XMx16 cards or VibroSmart devices in the tree structure or some cards 

are missing, verify your network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use 

CTRL+click or SHIFT+click to select multiple devices from the Devices tree-view. (Then, when 

the Change Firmware command is run, all of the devices that were selected will be updated at 

the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the 

device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 

corresponding to the VibroSight-compatible VM600 card or VibroSmart device 

selected. 

.tgz files are for VM600 cards and .*fw files are for VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 

5 minutes, during which: 

 The IP address beside the device’s serial number in the Devices tree structure can 

disappear. 

 The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 

independently of the VibroSight software (once the process has started), firmware 

updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of 

firmware. It is therefore possible to change a device’s firmware to any previously available version, as 

well as the latest update. 
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This feature can be useful in certain situations, for example, swapping spare VibroSight hardware 

between different VM600 racks or VibroSmart distributed monitoring systems, where systems are 

operating with different versions of VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been 

inadvertently modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data 

acquisition and external interfaces, data post-processing and/or logging are all configured as 

expected. 

 

In a VibroSight Server user interface: 

 On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus 

controls are enabled or disabled as required by your application. 

 On the Status tab under Server features, check that the Basic math, Air gap, Combustion 

monitoring, Duration counters, VSHDA import and Data logging manager controls are enabled or 

disabled as required by your application. 

 On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 

(VM600 cards and /or VibroSmart modules) have been discovered and that data acquisition has 

resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 

Server user interface is not displayed, so VibroSight System Manager must be 

used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 

in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any 

VibroSight Servers in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt Sensing Systems worldwide customer support network offers a range of support including 

Technical support and Sales and repairs support. For customer support, please contact your local 

Meggitt Sensing Systems representative. Alternatively, contact our main office: 

Meggitt SA 

Customer support department 

Route de Moncor 4 

PO Box 1616 

1701 Fribourg 

Switzerland 

 

Telephone: +41 (0) 26 407 11 11 

Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt Sensing Systems technical support team provide both pre-sales and post-sales technical 

support, including: 

 General advice 

 Technical advice 

 Troubleshooting 

 Site visits. 

 

7.3 Sales and repairs support 

Meggitt Sensing Systems sales team provide both pre-sales and post-sales support, including advice 

on: 

 New products 

 Spare parts 

 Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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Appendix 
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VibroSight software and Windows operating system compatibility 

 

 

Windows 7 Windows 8.1 Windows 10 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows 7 ends in January 2020).  

Yes Yes 

 

 

VibroSight software and Windows Server operating system compatibility 

 

 

Windows Server 2008 R2 Windows Server 2012 Windows Server 2016 

VibroSight software compatible? 

Yes 

(but not recommended for new 

installations as Microsoft support for 

Windows Server 2008 R2 ends in 

January 2020) 

Yes Yes 
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VibroSight software and Microsoft .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.4.0 or later .NET Framework 4.7.1 
See note 1

 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 
See note 2

 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

2. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers 

(rather than installing Microsoft .NET Framework 2.0). 
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